I. Introduction

The purpose of this document is to provide a functional overview of the Computer Microvision User Interface software components and describe the usage of these components with the standard pre-recorded dataset (folded-beam resonator).

II. Functional Overview

Computer Microvision

The Computer Microvision workstation is a tool for in situ motion analysis of microelectromechanical systems (MEMS). Hardware components of the workstation include a light microscope with a movable stage, a CCD camera, a signal generator, and a PC (see Figure 1). During experimentation, a MEMS device is placed on the stage, driven with a periodic signal and imaged through the microscope with the CCD camera. An LED is strobed once per stimulus period at a chosen phase to yield a snapshot of the device position. This process is repeated at several stimulus phases and at several locations of the stage, resulting in a 4D dataset which represents the motion of the device through one period. Computer vision algorithms are then applied to this 4D dataset to quantify the device motion as space versus time curves. From these curves, the periodic motion of the device is determined. This process is repeated at other stimulus frequencies and/or amplitudes to characterize the device with respect to other devices or a theoretical standard.

User Interface

In addition to the hardware components described above, the Computer Microvision workstation includes a number of custom software drivers which run on the PC. These software drivers are termed “basis functions” and are implemented as UNIX command-line programs. The laboratory usage of the Microvision workstation involves the development of custom scripts which form appropriate calls to the basis functions for each new experiment. In order to provide a more streamlined presentation to the experimentalist, the Computer Microvision User Interface was developed. The User Interface is a relatively “thin”, graphical shell of functionality which provides a number of useful abstractions over the experimental process and which performs direct interaction with the basis functions.

There are four major components to the user interface:

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microvision Acquisition</td>
<td>experiment configuration and data acquisition</td>
</tr>
<tr>
<td>Microvision Analysis</td>
<td>multi-function dataset analysis</td>
</tr>
<tr>
<td>Microvision Viewer</td>
<td>4D image data browsing</td>
</tr>
<tr>
<td>Microvision Plotter</td>
<td>multi-function data plotter</td>
</tr>
</tbody>
</table>

Each of these will be described in turn below.
Microvision Acquisition

The Microvision Acquisition application provides a streamlined interface to performing experiments with the Computer Microvision workstation (see Figure 2). The main panel consists of three main functional areas:

**Experiment Configuration.** This area provides a button-panel interface for performing a variety of experimental setup functions, such as the specification of a variety of hardware parameters, the acquisition of sample images, the determination of appropriate focal planes and the verification of device motion in response to sample stimuli.

**Data Acquisition.** This area provides an abstraction over the experimental process. As mentioned above, the basic unit of data supported by Microvision is a 4D image: 2D images collected from the camera at different heights of the stage (“planes”) and stimulus offsets (“phases”). Conceptually, this 4D image is comprised of 3D snapshots of the device position throughout its range of motion. The motion is in response to a particular stimulus condition. Microvision Acquisition extends the basic unit to a 5D image, where numerous 4D images are collected over a range of stimulus conditions (“parameters”). Currently, two types of parameters are supported: the *amplitude* or *frequency* of the driving signal. The interface provides an option menu for the specification of parameter type and individual list boxes for the specification of desired parameters, planes and phases. Since the data must be acquired sequentially (one 2D image at a time), the user can choose the order through which each list will be iterated via the option menus adjacent to the list boxes. Also supported is the specification of a crop region for the acquired image, in the event that the area of interest is significantly smaller than the field-of-view of the full camera image. After an experiment has been specified, the user can queue the experiment for a batch run to be performed at a later time or run the acquisition immediately. During data acquisition, a progress dialog illustrates the status of the experiment, the percentage complete and provides a “stop” button to cancel the experiment. Once data has been acquired, the existing configuration is saved and may be loaded (via a menu item) at a later time to view or to use as a template for a future experiment.

**Queue.** A typical data acquisition can take on the order of thirty minutes. Often, a set of acquisitions are desired across different parameter spaces. To force the user to return to the system periodically to change a single parameter is not desirable. In order to avoid this situation, the queue provides the ability to aggregate a number of different experiments and to run the aggregate in an automated fashion. As each acquisition completes, it is removed from the queue. In the event of a user interruption or error condition, only the experiments which have not been completed remain in the queue.

In addition to the functional areas described above, a logging feature writes a time-stamped entry to a log file for each command executed by the user interface. In this manner, a journal of the steps taken in any experiment is automatically kept for future reference.

**Microvision Analysis**

The Microvision Analysis application provides a streamlined interface to performing two types of data analysis and a variety of visualization functions with Microvision datasets (see Figure 3). The main panel consists of three main functional areas:
**Experiment Information.** This area provides information on the currently loaded experiment. Such information includes the name of the dataset, the type of experiment and the number of planes, phases and parameters collected.

**Analyses.** There are two analysis types supported by the interface: translation analysis and dots. The most basic form of analysis for Microvision data is the translation analysis. Input for this analysis includes a unique name and a region-of-interest (ROI) specification. Running the analysis calls a basis function which extracts space versus time motion curves for each 4D image within the specified dataset. A more advanced analysis, termed dots, extends the translation analysis to multiple ROIs. Running this analysis calls another basis function which performs the translation analysis on each ROI for each 4D image and aggregates the results. In each case, ROIs are selected via a graphical display which contains a sample image and allows the user to “rubberband” rectangular regions. During execution of either analysis, a progress dialog is displayed with an indication of the percentage complete. Upon successful completion, the interface is updated to reflect the new analysis results.

**Visualize.** Once an analysis has been completed, the user has the opportunity to visualize the results. At the top of this area is an option menu, which allows the user to specify which analysis is to be the target of the visualization. Four functions are supported: viewing raw experimental data for a given parameter, viewing motion data for a given parameter, viewing a spectrum plot of the full experiment, and viewing an animation of a dots analysis.

**Microvision Viewer**

The Microvision Viewer application is a full-featured multi-dimensional image browser (see Figure 4). It provides the following core functionality:

**Image Display.** The Microvision Viewer supports the loading of 2D, 3D and 4D images via command-line specification or via a pop-up file dialog box. It is called from the Microvision Analysis application when viewing raw data. The currently specified image or sub-image is displayed in the main window.

**Permutation.** Since a 2D display, such as a screen, can only display a 2D image, some metaphor must be employed to view higher-dimensional images. The permutation panel provides one such metaphor. In this model, the user can “map” image dimensions (i.e. x,y,plane,phase) into screen dimensions (u,v,time). Here, ‘u’ and ‘v’ represent the 2D screen space and ‘time’ represents animation. For example, the mapping ( x->u, y->v, plane->time ) would cause a single (x,y) image at a constant plane and phase to be displayed. If the “play” button was pressed (see below), other (x,y) images at successive planes would be displayed. Similarly, the mapping ( x->u, y->v, phase->time ) would display (x,y) images as a function of phase. In addition to specifying the mapping, the permutation panel allows the user to “crop” the displayed image to a given size and to adjust the scaling of the image intensity value (i.e. gamma scaling).

**Animation.** The animation panel provides the ability to manually or automatically step through the ‘time’ dimension as specified in the permutation panel. The play mode (once-through, loop and swing) and play rate can also be specified.

**Plot.** The Microvision Viewer also supports the plotting of motion curves as extracted by Microvision Analysis. An option menu provides the ability to select an analysis. Sub-
panels display the motion estimates for each dimension. Also, the ROI used for the analysis may be overlaid on the image displayed in the main window. If the permutation maps phase into time, the plots are animated during playback of the image data.

**Microvision Plotter**

The Microvision Plotter application provides a variety of 2D data plotting functionality for illustrating data produced by Microvision Analysis (see Figure 5). This application provides functionality for displaying motion curves and sweeps of aggregate quantities calculated by the analysis scripts. The axes support both linear and logarithmic scaling. Labels at the bottom of the interface display the current location of the pointer in plot coordinates and the currently selected plot point. A checkbox allows the individual plots to be scaled relative to the largest value in all plots or relative to the largest value in each individual plot. A “Print” menu item and associated dialog provides the ability to save the current screen as a PostScript file or print the image to the specified printer.

## III. Usage Tutorial

### Overview

This section provides a brief tutorial-style walkthrough of the various Microvision applications using the standard pre-recorded dataset of a folded-beam resonator. The walkthrough is written for application version 0.5, delivered in late June 1999. In any Microvision application, the version number may be found in the “About” box, displayable via the “Help” menu.

### Startup

A web server has been established at MIT which contains links to both the application software and this documentation (in PDF format). The URL for this server is:

http://resonator.mit.edu

Instructions for application startup and local display requirements can be found there.

**Note:** Since the Microvision applications are written using the X Window System, the local workstation must be running some style of X server. Thus, ordinary PCs with no commercial X software will be unable to run these applications.

### Microvision Acquisition

Launching the Microvision software from the “Computer Microvision” link on the website above should bring up the main panel of the Microvision Acquisition application. This panel should appear as in Figure 2, with the exception that all of the entry fields except “ROI” should be blank. This subsection will review the steps necessary to perform a simple data acquisition using the interface.

The overall flow of an experiment is as follows:

- specify a new experiment name or load an existing experiment template
- specify hardware-related parameters
- obtain sample imagery to center device within field-of-view and to validate motion
- specify dataset-related parameters, such as resolution in spatial and time dimensions
- run the experiment or queue it for later execution
Each step will be reviewed in turn below.

A. Specify Experiment Name

1) Pull down the “File” menu and select “New…” A dialog box appears with a single entry field. Enter a name for the experiment, such as “resonator”, and click “OK”. The name you entered should appear in the field next to “Experiment Name” in the “Data Acquisition” frame. This action has cleared all parameters to their defaults and set the name of the current data acquisition.

B. Specify Hardware Parameters

1) Click the “View Parameters” button in the “Experiment Config” frame. A large dialog box appears which contains a number of entry fields, grouped into several sections. These fields represent all user-modifiable hardware parameters. Since this walkthrough employs a pre-recorded dataset, very few of these parameters have any effect on the operation of the system. However, to demonstrate the functionality, change the “Frequency” entry from its default of “469” to “8882”. The dialog may be kept up or dismissed with the “Close” button.

C. Obtain Sample Imagery

1) Click the “Obtain Sample Image…” button in the “Experiment Config” frame. A dialog box appears which contains an entry field and a button. The “Position” entry field represents the device’s position as measured from the microscope objective. The “Acquire” button takes a picture from the camera and displays it via the Microvision Viewer application. When using actual hardware, this feature allows the user to obtain an image of what is currently in view through the microscope in order to center the device within the view area. With the pre-recorded data, however, only one view is available. Simply click “Acquire”. After a short delay, the viewer application comes up, with an image similar to that of Figure 4. The viewer application will be discussed in more detail below. For now, dismiss it by selecting “Quit” from the “File” menu. Dismiss the dialog by clicking the “Close” button.

2) Click the “Find Focal Planes…” button, which displays a dialog with several entry fields and an “Acquire” button. The entry fields allow the specification of a range of positions (“Start” and “End”) and the “Step” value between them. When using the actual hardware, this feature allows the user to obtain a series of images at different focal depths (termed “planes”) and to sequence through them via the viewer application. Through several iterations of this process with different endpoints, the user can determine the location of the plane of best focus and an optimal range of planes which span the device in the out-of-plane (i.e. z) dimension. With the pre-recorded data, however, only a single focal plane is available. Any number of planes can be requested, but the same image will be returned. Clicking “Acquire” with the default values of “60” for “Start”, “84” for “Stop” and “6” for “Step” will return five identical images and load them into the viewer. When the viewer comes up this time, two panels are displayed: the main image panel and an “Animate” panel. Clicking “Play” (the third button from the left) begins automated sequencing of the images. Since the images are identical, no motion is apparent (though the label next to “Slice” in the “Animate” panel displays the current slice number). Click “Stop” (the button
to the left of play) and then select “File|Quit” to dismiss the viewer. Dismiss the
dialog by clicking the “Close” button.

3) Click the “Test For Motion…” button, which displays a dialog with entry fields for
the “Amplitude” and “Frequency” of the driving stimulus and an entry for the
“Number of Phases” to acquire. When using actual hardware, this feature allows the
user to test the device at a given stimulus condition to verify expected operation. The
pre-recorded dataset consists of a single amplitude, fifty-two frequencies and eight
phases. The frequencies must match the actual test frequencies exactly (use a value
of “8882” here) and “8” phases must be specified. The amplitude value is not used.
Clicking “Acquire” with these values returns eight images and loads them into the
viewer. This time, the viewer starts with three panels displayed: the main image
panel, the "Animate" panel and the “Permute” panel. The “Permute” panel is used to
map 4D data into sets of 2D displayable images. For this demonstration, select “T
axis” in the option menu under the “Slice” label (notice that the option menu under
the “Constant” label changes to “Z axis”), and click “Go”. This action remaps
the dataset to show images at a constant focal depth (“Z”) as a function of phase (“T”).
Clicking “Play” on the “Animate” panel starts the animation. The comb drive in the
main image panel should appear to move noticeably. Click “Stop” and then select
“File|Quit” to dismiss the viewer. Dismiss the dialog by clicking the “Close” button.

C. Specify Dataset Parameters

At this point, the configuration of the experiment from the hardware perspective is
complete. In this step, the shape and size of the acquired data is specified in the “Data
Acquisition” frame. If the actions listed above have been followed as indicated, several
of the fields should already be filled. Specifically, “Experiment Name” should contain
the value “resonator”, the “Plane List” box should contain the values “60 66 72 78 84”
and the “Phase List” box should contain values from “0” to “7”. Other fields include:

1) Test Parameter. The current software allows for testing across two different
parameters: the “Amplitude” or “Frequency” of the stimulus. Since the pre-recorded
dataset is a frequency test, make sure “Frequency” is selected in the option menu.

2) ROI. In some data acquisitions, the area of interest may be significantly smaller than
the full field-of-view of the camera. In this case, it would be wasteful to save all of
the data collected by the camera. The ROI (region of interest) feature allows the user
to specify a single rectangular area to use as a crop mask. All data outside of the
rectangle will be discarded before saving to disk. In the pre-recorded dataset, this
feature is not supported and is disabled. The string “roimax” in the entry box
indicates use of the full camera field-of-view.

3) Parameter Range. In order to specify the values of the test parameter to iterate over,
click the “Edit…” button within the “Parameter Range” sub-frame. The “Edit List”
dialog is displayed, which supports the generation of list values. The full description
of this dialog is beyond the scope of this document. For this demonstration, enter the
values:

845,2656,7589,8239,8882,9464,11250
in the top entry field (next to the “List:” label) and click “OK”. Note that the values must be separated by commas. As stated above, the pre-recorded data consists of fifty-two frequencies, and values specified through the interface must match those exactly. The full list is enumerated in Appendix A. For this demonstration version of the applications, limit the number of frequencies requested to ten or less in order to keep disk usage to a reasonable level.

E. Run Experiment

After the hardware has been configured and the dataset specified, the experiment may be run in immediate mode or queued for later execution (which will not be discussed here). To run in immediate mode:

1) Click “Run…” in the “Data Acquisition” pane to begin the experiment. A progress dialog is displayed, which provides a thermometer-style indicator of percentage complete and an option to “Stop” the acquisition. Upon completion (approximately one to two minutes), the “Data Taken” flag at the top of the “Data Acquisition” frame lights up and a full dataset has been successfully acquired.

2) Once data has been acquired, analysis may be performed. From the “Analyze” menu, select “cmanl”. This action launches the Microvision Analysis application.

Microvision Analysis, Viewer and Plotter

The Analysis application should appear as in Figure 3. If the steps above have been performed as indicated, the “Experiment Information” frame will contain the name of the dataset and its shape (i.e. size of each dimension). The flow of a typical data analysis is as follows:

- run an analysis
- visualize the results

Each step will be reviewed in turn below.

A. Run Analysis

1) Enter a name for the analysis, such as “tooth”, in the entry field next to “Analysis Name”. Each analysis is tagged with a unique name which is used to store and identify its data.

2) Click the “Specify…” button to the right of “ROI”. A dialog appears which contains a sample image from the dataset. When the cursor is over the image, a rectangular region may be rubberbanded by clicking and sweeping out an area. Note that a thin rectangular line follows the sweeping motion. Releasing the mouse button completes the operation. Repetition of these actions deletes the original swept area and creates a new one. Practice this a few times to get the feel of how this works. Once an area has been swept, the arrow keys move the area as a unit one pixel in the specified direction. Holding down the “Control” key while using the arrow keys modifies the size of the area by one pixel in the specified direction. The labels below the image display the current position of the pointer, as well as the start and end of the currently swept region. Below these labels are two sliders which allow specification of the depth of the region in the out-of-plane (i.e. z) dimension. Sweep out an area around one of the top teeth of the comb structure, such that the start is near (150,80)
and the end near (165,130). Keep the “Z” sliders as they are (“0” for “Min” and “4” for “Max”), and click “OK”. This dismisses the dialog and places values representing the swept area into the entry field next to the “ROI” label.

3) At this point, the analysis has been fully specified. Click the “Run…” button to execute the analysis on the dataset. A progress dialog appears during execution, which should last only a few seconds. Once complete, the “Analysis Name” and “ROI” entry fields are cleared and the “Visualize” frame is updated to reflect the new analysis.

B. Visualize Results

1) The “Analysis” option menu at the top of the “Visualize” frame lists all of the analyses which have been performed on the given dataset. The currently selected analysis becomes the object of the three visualization functions within this frame. Since only one analysis has been performed (as described above), there is only one entry in the menu.

2) The “View Raw Data” function provides a means of inspecting the imagery acquired by the Microvision system via the Viewer application. A single option menu allows the user to select which “Parameter” value within the dataset to view. Select a value of “8882” and click “View…”. This loads the 4D dataset associated with frequency 8882 into the Viewer. This dataset can be remapped and animated as described in section B.3 of the Microvision Acquisition tutorial above. When launched from the Analysis application, a plotting feature is also available. Select “Plot” from the “Control” menu. A fourth panel appears which contains 2D plots of the estimated motion for the given analysis. The option menu at the bottom of the panel allows the user to select other analyses to view. When animating the image via the “Play” button in the “Animate” panel, an indicator in the plot is also dynamically redrawn, indicating the location in the plot corresponding to the animation. Selecting the “ROI” checkbox at the bottom of the panel displays an outline of the ROI used for the given analysis. The “Motion Correct” checkbox is currently not implemented. Stop the animation and select “File|Quit” from the main viewer panel to dismiss it.

3) The “View Motion Data” function provides a means of inspecting the results of the data analysis. Two option menus allow the user to select the “Parameter” value and the “Type” of data to view. There are two types of motion data: the “Raw” output of the motion estimator, which corresponds to the velocity (displacement/time) measured within the ROI, and integrated “Position” curves, which correspond to actual displacements. Select a parameter value of “8882” and a type of “Position”, and click “View…” . This loads the specified motion data into the Plotter, which displays individual plots for each of the spatial dimensions (in-plane: “x” and “y”; and out-of-plane: “z”). Placing the cursor within one of the plot areas causes crosshairs to be drawn from the current position to the axes and the current position in plot coordinates to be displayed in a label at the bottom of the interface. If the cursor is placed near a plotted point, the crosshairs change color. Clicking the left mouse button causes the value of the point itself to be placed in another label at the bottom of the interface. The checkbox next to this label allows the scaling in the vertical dimension to be either relative to each individual plot (unselected) or relative
to all plots (selected). This feature allows the comparison of the relative sizes of each motion. The plots may be printed via the “File|Print” menu, either as a PostScript file or to a local printer. Select “File|Quit” from the menubar to dismiss the interface.

4) The “View Spectrum” function provides a means of viewing aggregated motion results over the entire 5D dataset. The “View Motion Data” function described above plots the estimated position curves for a given 4D dataset. The spectrum plot reduces the position curves to a single aggregate value. An option menu allows the user to specify the “Type” of aggregate value. “Magnitude” represents the displacement from peak-to-peak of the fundamental sinusoid of the position curve; i.e. a measure of the overall magnitude of the motion at the given stimulus. “Phase” represents the phase offset of the fundamental sinusoid from the input signal. Choose “Magnitude” and click “View…”, and then choose “Phase” and click “View…”.

Arrange the plot windows so they are adjacent to each other. These plots represent the overall response of the device in each dimension across a range of stimulus conditions. The primary mode of motion is in the “y” dimension, and, in this dimension, the plots resemble what one would expect from a second-order resonance system. In the “x” dimension, the motions are much smaller, but a significant peak can be found at the resonant frequency. Since the “z” dimension is comprised of identical images, no motion is apparent. Select “File|Quit” from both plots to dismiss the windows.
Figure 1: Schematic of Computer Microvision System
**Figure 2:** Microvision Acquisition Interface
Figure 3: Microvision Analysis Interface
Figure 4: Microvision Viewer Interface: Main, Permute and Animate Panels
Figure 5: Microvision Plotter Interface
Appendix A -- Allowable Frequency Values.

The following is a list of the frequency values available in the standard pre-recorded dataset (i.e. folded-beam resonator):

<table>
<thead>
<tr>
<th>Frequency 1</th>
<th>Frequency 2</th>
<th>Frequency 3</th>
<th>Frequency 4</th>
<th>Frequency 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>469</td>
<td>536</td>
<td>625</td>
<td>727</td>
<td>845</td>
</tr>
<tr>
<td>986</td>
<td>1122</td>
<td>1287</td>
<td>1488</td>
<td>1736</td>
</tr>
<tr>
<td>1989</td>
<td>2302</td>
<td>2656</td>
<td>3052</td>
<td>3551</td>
</tr>
<tr>
<td>4107</td>
<td>4735</td>
<td>5467</td>
<td>6250</td>
<td>7291</td>
</tr>
<tr>
<td>7589</td>
<td>7670</td>
<td>7730</td>
<td>7812</td>
<td>7887</td>
</tr>
<tr>
<td>7939</td>
<td>8034</td>
<td>8173</td>
<td>8239</td>
<td>8285</td>
</tr>
<tr>
<td>8393</td>
<td>8482</td>
<td>8576</td>
<td>8640</td>
<td>8717</td>
</tr>
<tr>
<td>8807</td>
<td>8882</td>
<td>8953</td>
<td>8994</td>
<td>9046</td>
</tr>
<tr>
<td>9135</td>
<td>9219</td>
<td>9299</td>
<td>9375</td>
<td>9464</td>
</tr>
<tr>
<td>9549</td>
<td>9659</td>
<td>9738</td>
<td>11250</td>
<td>12993</td>
</tr>
<tr>
<td>14970</td>
<td>17321</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>